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Read This First

Welcome to the Thermo Scientific, LTQ Orbitrap™ system! The 
LTQ Orbitrap is a member of the family of LTQ™ mass spectrometer (MS) 
detectors.

This LTQ Orbitrap Getting Started manual provides you with information 
on how to set up, calibrate, and tune the LTQ Orbitrap. Procedures in 
Chapters 1–4 can be performed from the Xcalibur® Tune Plus window.

LTQ Orbitrap Getting Started includes the following chapters:

• Chapter 1: “Introduction” provides general information about this 
manual. 

• Chapter 2: “Tune Plus Window” provides information on the Tune Plus 
window.

• Chapter 3: “Calibrating the LTQ Orbitrap for FTMS Measurements” 
provides procedures to calibrate your LTQ Orbitrap for 
FTmeasurements.

• Chapter 4: “Performing Diagnostics/Checks” describes several 
diagnostic procedures.

• Chapter 5: “Instrument Setup” describes the FT relevant topics of the 
data dependent settings in the Instrument Setup.

• Chapter 6: “Instrument Configuration” gives instructions about 
configuring your instrument.

• Appendix A: “Miscellaneous Information” gives additional information 
about various topics.
Thermo Fisher Scientific LTQ Orbitrap Getting Started i



Preface
Changes to the Manual
Changes to the
Manual

To suggest changes to this manual, please send your comments to:

Editors, Technical Documentation
Thermo Fisher Scientific
Hanna-Kunath-Str. 11

28199 Bremen

Germany

documentation.bremen@thermo.com

You are encouraged to report errors or omissions in the text or index.
Thank you.
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Preface
Typographical Conventions
Typographical
Conventions

Typographical conventions have been established for Thermo Fisher 
Scientific manuals for the following:

• Data input

• Admonitions

• Topic headings

Data Input Throughout this manual, the following conventions indicate data input and 
output via the computer: 

• Messages displayed on the screen are represented by capitalizing the 
initial letter of each word and by italicizing each word.

• Input that you enter by keyboard is identified by quotation marks: 
single quotes for single characters, double quotes for strings.

• For brevity, expressions such as “choose File > Directories” are used 
rather than “pull down the File menu and choose Directories.”

• Any command enclosed in angle brackets < > represents a single 
keystroke. For example, “press <F1>” means press the key labeled F1.

• Any command that requires pressing two or more keys simultaneously is 
shown with a plus sign connecting the keys. For example, “press 
<Shift> + <F1>” means press and hold the <Shift> key and then press 
the <F1> key.

• Any button that you click on the screen is represented in bold face 
letters. For example, “click on Close”.
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Typographical Conventions
Admonitions Admonitions contain information that is important, but not part of the 
main flow of text.

Admonitions can be of the following types:

• Note – information that can affect the quality of your data. In addition, 
notes often contain information that you might need if you are having 
trouble.

• Caution – information necessary to protect your instrument from 
damage.

• Warning – hazards to human beings. Each Warning is accompanied by 
a Warning symbol.

Topic Headings The following headings are used to show the organization of topics within a 
chapter:

Chapter Name

The following headings appear in the left column of each page:

Second Level Topics

Third Level Topics

Fourth Level Topics
iv LTQ Orbitrap Getting Started Thermo Fisher Scientific



Preface
Safety and EMC Information
Safety and EMC
Information

In accordance with our commitment to customer service and safety, these 
instruments have satisfied the requirements for the European CE Mark 
including the Low Voltage Directive.

Designed, processor and tested in an ISO9001 registered facility, this 
instrument has been shipped to you from our manufacturing facility in a 
safe condition.

Caution This instrument must be used as described in this manual. Any use 
of this instrument in a manner other than described here may result in 
instrument damage and/or operator injury. ▲

Identifying Safety
Information

The LTQ Orbitrap Getting Started contains precautionary statements that 
can prevent personal injury, instrument damage, and loss of data if properly 
followed. Warning symbols which alert the user to check for hazardous 
conditions appear throughout the manual, where applicable, and are 
defined in Table i.

Table i. Warning Symbols

Symbol Description

General This general symbol indicates that a hazard is present, which if 
not avoided, could result in injuries. 

The source of danger is described in the accompanying text. ▲

Electric Shock High voltages capable of causing personal injury are 
used in the instrument. The instrument must be shut down and 
disconnected from line power before service or repair work is 
performed. ▲

Hot Surface / Heat Allow heated components to cool down before 
servicing them! ▲
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Safety and EMC Information
Instrument-Specific
Hazards

Every instrument has specific hazards, so be sure to read and comply with 
the following precautions. They will help ensure the safe, long-term use of 
your system.

1. Before plugging in any of the instrument modules or turning on the 
power, always make sure that the voltage and fuses are set appropriately 
for your local line voltage.

2. Only use fuses of the type and current rating specified. Do not use 
repaired fuses and do not short-circuit the fuse holder.

3. The supplied power cord must be inserted into a power outlet with a 
protective earth contact (ground). When using an extension cord, make 
sure that the cord also has an earth contact.

4. Do not change the external or internal grounding connections.
Tampering with or disconnecting these connections could endanger you 
and/or damage the system.

Caution The instrument is properly grounded in accordance with 
regulations when shipped. You do not need to make any changes to the 
electrical connections or to the instrument’s chassis to ensure safe 
operation. ▲

5. Never run the system without the housing on. Permanent damage can 
occur.

6. Do not turn the instrument on if you suspect that it has incurred any 
kind of electrical damage. Instead, disconnect the power cord and 
contact a service representative for a product evaluation. Do not attempt 
to use the instrument until it has been evaluated. (Electrical damage 
may have occurred if the system shows visible signs of damage, or has 
been transported under severe stress.)

7. Damage can also result if the instrument is stored for prolonged periods 
under unfavorable conditions (e.g., subjected to heat, water, etc.).
vi LTQ Orbitrap Getting Started Thermo Fisher Scientific
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8. Always disconnect the power cord before attempting any type of 
maintenance.

9. Capacitors inside the instrument may still be charged even if the 
instrument is turned off.

10. Never try to repair or replace any component of the system that is not 
described in this manual without the assistance of your service 
representative.
Thermo Fisher Scientific LTQ Orbitrap Getting Started vii
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Chapter 1 Introduction

This manual describes only the FTMS detector relevant settings and 
procedures of the LTQ Orbitrap software (Tune plus version 2.2). For ion 
trap relevant settings and procedures, refer to the Finnigan LTQ Getting 
Started manual.

In addition to this manual, the LTQ Orbitrap Tune Plus Online Help gives 
information to specific topics. Nevertheless, it is recommended to read this 
manual entirely.
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Chapter 2 Tune Plus Window

This chapter provides LTQ Orbitrap specific information about the Tune 
Plus window. It contains the following topics:

• “Preliminary Remarks” on page 2-2

• “View Menu” on page 2-3

• “Scan Mode Menu” on page 2-8

• “Display Menu” on page 2-12

• “Setup Menu” on page 2-13

• “Tune Methods” on page 2-18
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Tune Plus Window
Preliminary Remarks
Preliminary Remarks The Tune Plus window shows the schematic view of the LTQ Orbitrap and 
the instrument name. See Figure 2-1. 

Note The Tune Plus window needs a minimum screen resolution of 
1152×864 to be fully displayed. ▲

To access the functions of the Tune Plus window, use the menu commands, 
toolbar buttons, and display views. The FT relevant changes or additions of 
the menu commands, toolbar buttons, and display views are explained in 
the following chapters.

Figure 2-1. Tune Plus window
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Tune Plus Window
View Menu
View Menu This section describes those elements of the View menu that are different 
from the LTQ version of the Tune Plus window.

Spectrum View The Spectrum view displays real-time ion trap or FT mass spectra 
depending on the analyzer type selected in the Define Scan dialog box. See 
Figure 2-2.

The Spectrum View page has a shortcut menu that is displayed when you 
right-click anywhere on the page. To open the Spectrum Display Options 
dialog box, choose Display Options. The dialog box has two tabs, Ion 
Trap, and FT.

Figure 2-2. Spectrum View page
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Tune Plus Window
View Menu
 

On the FT tab, you can determine the number of decimals shown on peak 
labels. See Figure 2-3. To change the number of decimals, click on the 
arrows in the spin box to increment [up arrow] or decrement [down arrow] 
the value. You can set the number of decimals to any value from 0 to 5. 
Alternatively, you can enter a value in the spin box text field. The 
LTQ Orbitrap changes the number of decimals when you click on Apply or 
OK.

A check box allows you to show additional analyzer information for 
FTMS scans. This information will be displayed above the spectrum graph 
if the box is checked. See “FT Analyzer Messages” on page A-3 for a list of 
items that may be displayed as analyzer information.

You can also decide whether or not to show the resolution and/or the charge 
state of peaks in the FT spectrum by clearing or checking the corresponding 
check boxes.

If the FTMS analyzer is used, it is possible to display different diagnostic 
views in the spectrum view. See Chapter 4: “Performing 
Diagnostics/Checks” for diagnostic features that involve the spectrum view.

Figure 2-3. Spectrum Display Options dialog box - FT tab
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Tune Plus Window
View Menu
Graph View The Graph view displays, in a variety of traces, real-time data generated 
during calibration, tuning, and diagnostic tests. For example, Figure 2-4 
shows the progress of the FT transfer multipole frequency calibration.

Status View The Status view displays real-time status information for the LTQ Orbitrap. 
See Figure 2-5 on page 2-6. The Status view has two pages, i.e the All and 
User page. The Status view - All page displays the real-time status 
information for about 80 parameters of the LTQ Orbitrap. You can scroll 
through the list to observe the status of the parameters. The Status view - 
User page displays real-time status information for LTQ Orbitrap 
parameters that you have selected in the User Status Display Configuration 
dialog box. (See page 2-6.)

Figure 2-4. Graph view page
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Tune Plus Window
View Menu
User Status Display
Configuration Dialog Box

Figure 2-6 on page 2-7 shows the User Status Display Configuration dialog 
box. Use the following procedure to configure the user page:

1. Choose View > Display Status View.

2. Click on the User tab. Right-click on the User page to display the 
shortcut menu.

3. Choose Configure.

Figure 2-5. Status view page - All tab
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Tune Plus Window
View Menu
Figure 2-6. User Status Display Configuration dialog box
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Tune Plus Window
Scan Mode Menu
Scan Mode Menu This section describes the elements of the Scan Mode menu that are 
different from the Finnigan LTQ.

Define Scan The Define Scan dialog box allows you to define a scan in various ways 
depending on the scan mode and scan type combination. Also, the Define 
Scan dialog box allows you to choose the ion trap or the OT analyzer as 
analyzer. Figure 2-7 shows the Define Scan dialog box showing the 
Advanced Scan features. The Advanced Scan features can be activated in the 
Scan Mode menu of Tune plus.

Scan Description The Scan Description group box contains the following elements:

Figure 2-7. Define Scan dialog box

Analyzer At the top, the Analyzer list box allows you to select 
the analyzer type used during the currently selected 
scan event. The options are as follows:

• FTMS selects the Orbitrap detector.

• Ion Trap selects the ion trap detector.
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Tune Plus Window
Scan Mode Menu
Scan Time The Scan Time group box contains the following elements:

Mass Range The following mass ranges are available:

• Low: 15–200 for ion trap analyzer only

• Normal: 50–2000 for ion trap and FTMS 
analyzer

• High: 100–4000 for ion trap and FTMS 
analyzer

Scan Rate / Resolution When you have selected the entry ion trap in the 
Analyzer list box, this list box allows you to set the 
scan rate (Normal, Enhanced, Turbo, Zoom, 
UltraZoom).

When you have selected the entry FTMS in the 
Analyzer list box, this list box allows you to set the 
resolution of the FT mass spectra. The mass 
resolution is selectable between several options. 
Available resolution settings are 7500, 15000, 
30000, 60000, and 100000. 

Scan Type Usage of the scan types Full MS, SIM, SRM, or 
CRM is analogous to the ion trap with the 
exception that only one scan range is available for 
FTMS SIM, FTMS SRM, and FTMS CRM scans.

Microscans The number of microscans determines how many 
spectra are averaged in one analytical scan. If the 
FTMS is chosen as the analyzer, transients are 
averaged for one analytical scan.

The number of microscans can be set individually 
for FTMS, Ion Trap MS, FTMS SIM, Ion Trap 
SIM, FT MSn, Ion Trap MSn, and Ion Trap Zoom.

Max Inject Time The inject time is automatically controlled by the 
automatic gain control (AGC). The entry in this 
spin box limits the inject time to a maximum value. 
To ensure the high mass accuracy of the 
LTQ Orbitrap, the maximum inject time should 
not be reached. Otherwise, the number of ions does 
not correspond to the AGC target value. 
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Tune Plus Window
Scan Mode Menu
Locking The locking feature allows using one or more peaks in the spectrum as 
internal reference in order to improve mass accuracy. Locking is available for 
FTMS analyzer type.

Lock mass lists can consist of one or more lock masses. If the list contains 
lock masses that are (temporarily) not found in the spectrum, these lock 
masses are ignored (temporarily). For standard full scan experiments, it is 
expected that at least one of the lock masses is visible in the spectrum. 

The maximum inject time can be set individually 
for FTMS, Ion Trap MS, FTMS SIM, Ion Trap 
SIM, FT MSn, Ion Trap MSn, and Ion Trap Zoom.

Note If the maximum inject time is reached the 
number of ions may not correspond to the current 
AGC target value. This may harm the mass 
accuracy of FTMS spectra. ▲

Scan Time Settings By pressing the ALL... button of the Define Scan 
dialog box, the Scan Time Settings dialog box is 
displayed. It allows displaying and setting all scan 
time settings for all scan types at the same time for 
both the ion trap and the FT analyzer.

The locking feature can be enabled by activating the check box. When 
the Locking check box is activated, the Masses... button brings up a 
dialog box to enter and edit lock mass lists.

Figure 2-8. Lock Masses dialog box
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Tune Plus Window
Scan Mode Menu
There are two situations where the instrument makes use of a special mode 
to artificially mix the lock mass into the spectrum:

1. If none of the given lock masses is found in the full spectrum, the 
instrument tries to improve the abundance of the lock mass by 
performing additional SIM-injections of the specified lock mass. 

2. If the given lock mass can not be found in the spectrum because the 
instrument runs in MSn or SIM scan type, the instrument adds the lock 
mass by using SIM-injections.

This way, lock masses can be used for all FTMS scan types and for varying 
lock mass abundances. There is no need for user interaction other than 
specifying a list of reference peak candidates.

See “FT Analyzer Messages” on page A-3 on how to view information about 
the instruments locking state. See “Using Locking in Automated Runs” on 
page 5-2 on how to set FTMS locking in Instrument Setup.

Centroid/Profile With this pair of buttons you switch between the Centroid and the Profile 
format. The profile format for FTMS data is a compressed profile format. 
“FT Profile Mode” on page 4-8 describes how to switch to full profile 
format for FTMS data for diagnostic purposes.

For further information, see also topic “Data Size of FT Raw Files” on 
page A-4.

Positive/Negative With this pair of buttons you can toggle between positive ion and negative 
ion polarity. Different FT transfer, storage and mass calibration parameters 
are used for the different polarities.
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Tune Plus Window
Display Menu
Display Menu This section describes the elements of the Display menu that are different 
from the Finnigan LTQ.

Spectrum Averaging With this toggle, spectrum averaging can be switched on or off. If spectrum 
averaging is enabled the displayed spectrum is the moving average of several 
spectra before. Averaging FTMS scans is actually an averaging of transients. 

Use this functionality in analogy to ion trap scans:

1. In the Tune Plus window, choose Display > Spectrum Averaging > 
Settings… to display the Spectrum Averaging dialog box. See 
Figure 2-9.

2. Enter the number of transients to average into the spin box.

3. Click on OK to save your changes and close the dialog box.

Figure 2-9. Spectrum Averaging dialog box
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Tune Plus Window
Setup Menu
Setup Menu This section describes the elements of the Setup menu that are different 
from the Finnigan LTQ.

FT Transfer Optics The FT transfer parameters are only changed by an FT transmission 
calibration, which is usually only necessary when the hardware of the system 
is modified somehow. This dialog box displays the actual FT readback 
values for the current scan mode. See Figure 2-10.

To open this dialog box:

• From the Tune Plus window, choose Setup > FT Transfer Optics, or

• click on  in the Instrument Setup toolbar.

Figure 2-10. FT Transfer Optics dialog box
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Tune Plus Window
Setup Menu
FT Injection Control The Injection Control dialog box allows you to set the automatic gain 
control (AGC) target values. In addition, the Injection Control dialog box 
allows you to enable or disable the injection waveforms.

To open this dialog box:

• From the Tune Plus window, choose Setup > FT Injection Control, or

• click on  in the Instrument Setup toolbar.

The Injection Control dialog box has two tabs to enable an independent 
selection of target values for Ion Trap and FT scans.

Ion Trap Recommended target values for the ion trap:

Full MS Target: 3e+04

SIM Target: 1e+04

MSn Target: 1e+04

Zoom Target: 3000.0

Figure 2-11. Ion Trap tab of the Injection Control dialog box
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Tune Plus Window
Setup Menu
FT For FTMS measurements, only the Full MS target, the SIM target, and the 
MSn Target are used.

Recommended target values for the FT analyzer:

Full MS Target: 5e+05

SIM Target: 5e+04

MSn Target: 2e+05

Note Lower target values than those listed above may be used to obtain 
shorter inject times. For MSn scans, lower target values may also improve 
the isolation/fragmentation efficiency. Higher target values than those listed 
above can be used to improve the dynamic range. However, target values far 
above the recommended settings may affect isolation/fragmentation 
efficiency and mass accuracy for the FTMS analyzer. ▲

Enable Full Scan Injection
Waveforms

You can enable or disable the injection waveforms independently for ion 
trap and FT scans. 

If the injection waveforms are enabled, a filter on the ions injected into the 
ion trap is applied. The ions above and below the selected ion or ion range 
selected are rejected. This option is often useful if the ion trap is being filled 
with ions of greater or lesser mass than the ion mass or ion mass range of 
interest. For example, this option can be used to remove high mass ions that 
are not of interest and ensures that more target ions can enter the trap 
before the trap is full. 

Figure 2-12. FT tab of the Injection Control dialog box
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Note The FT injection waveforms option only applies to full scan MS scans 
performed with the Orbitrap mass analyzer. In FT SIM and FT MSn scans, 
the injection waveforms are automatically enabled. ▲

FT Vacuum The Vacuum dialog box allows you to monitor the vacuum system 
parameters. The Vacuum dialog box has two tabs to enable an independent 
selection of displaying the vacuum data of the ion trap or the FT part.

To open this dialog box:

• From the Tune Plus window, choose Setup > Vacuum…, or

• click on  in the Instrument Setup toolbar.

Figure 2-13. Ion Trap page of the Vacuum dialog box

Figure 2-14. FT page of the Vacuum dialog box
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FT Temperature Monitor The FT Temperature Monitor dialog box allows to view the status of the 
FTMS analyzer temperature regulation. Deviations of the actual 
temperature from the temperature setpoint can affect instrument 
performance. It is not possible to operate the instrument when the bakeout 
procedure is active.

To open this dialog box:

• From the Tune Plus window, choose Setup > FT Temperature 
Monitor…, or 

• click on  in the Instrument Setup toolbar.

Figure 2-15. FT Temperature Monitor dialog box
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Tune Methods Several parameters, like the ion source parameters, ion trap optics 
parameters, AGC target values etc., are stored in tune methods. This topic 
points out for which parameters a differentiation between ion trap and 
FTMS is made. The Tune Plus title bar displays the name of the current 
tune method. If you are not currently editing a preexisting tune method, the 
title bar displays the word Untitled. 

Parameters with
Differentiation between

Ion Trap and FT Scans

A differentiation between Ion Trap and FTMS scans is made for the 
following tune parameters.

AGC Target Values They can be set and saved independently for these experimental modes (no 
differentiation between positive and negative ion polarity mode):

• Ion Trap Full MS Target

• Ion Trap SIM Target

• Ion Trap MSn Target

• Ion Trap Zoom Target

• FT Full MS Target

• FT SIM Target

• FT MSn Target

Microscans and Maximum Inject
Time

They can be set and saved independently for these experimental modes:

• Ion Trap Full MS, positive ion mode

• Ion Trap SIM, positive ion mode

• Ion Trap MSn, positive ion mode

• Ion Trap Zoom, positive ion mode

• FT Full MS, positive ion mode

• FT SIM, positive ion mode 

• FT MSn, positive ion mode 
2-18 LTQ Orbitrap Getting Started Thermo Fisher Scientific



Tune Plus Window
Tune Methods
• Ion Trap Full MS, negative ion mode

• Ion Trap SIM, negative ion mode

• Ion Trap MSn, negative ion mode

• Ion Trap Zoom, negative ion mode

• FT Full MS, negative ion mode

• FT SIM, negative ion mode 

• FT MSn, negative ion mode 

Inject Waveform Flags The flag whether the inject waveform is enabled or disabled can be set and 
saved independently for 

• Ion trap scans

• FT full scans.

Parameters without
Differentiation between

Ion Trap and FT Scans

No differentiation between Ion Trap and FT scans is made for all ESI 
parameters, and for all ion source and ion optics parameters. 

Parameters not saved in a
Tunefile

All parameters which can be set in an instrument method are not saved in 
the tune method. Thus the following parameters are not saved in a tune 
method:

• Analyzer (Ion Trap or FTMS)

• Mass Range (Low, Normal, or High)

• Scan Rate 

• Resolution 

• Scan Type (Full, SIM, SRM, CRM)

• Scan Range

• Polarity* (positive or negative)
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• Data type* (centroid or profile)

* Only the data format (centroid or profile) and the ion polarity are saved in 
a tunefile that are set after a new start of TunePlus.
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Chapter 3 Calibrating the LTQ Orbitrap 
for FTMS Measurements

This chapter provides procedures to calibrate your LTQ Orbitrap for 
FTMS measurements. It contains the following topics:

• “Preliminary Remarks” on page 3-2

• “Calibration Files and their Backups” on page 3-3

• “Calibration Solutions” on page 3-4

• “Calibration and Tuning of the Ion Trap” on page 3-9

• “Automatic Calibration Tab” on page 3-13

• “Semi-Automatic Calibration Tab” on page 3-14

• “Check Calibration Page” on page 3-16

• “FT Manual Calibration Page” on page 3-19
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Preliminary Remarks
Preliminary Remarks There are no specific tune procedures for the FTMS. All FTMS ion transfer 
and excitation parameters are treated as calibration parameters and are 
determined in automatic calibration procedures.

In the automatic calibration, the FT transmission calibration and the 
FTmass calibration are automatically performed for all calibration ranges. 
In the semi-automatic calibration, it is possible to decide whether the 
transmission and/or mass calibration are performed only for the positive ion 
mode, only for the negative ion mode or for both polarities. See topics 
“Automatic Calibration Tab” on page 3-13 and “Semi-Automatic 
Calibration Tab” on page 3-14 for further details.

On the FT Manual calibration page, you can select your own calibration 
masses for FT ion transmission, storage transmission, and FT mass 
calibration. See topic “FT Manual Calibration Page” on page 3-19 for 
further details. 

Note It is recommended to use the semi-automatic calibration. ▲
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Calibration Files and
their Backups

After a successful or partly successful calibration, the ion trap and FT 
calibration parameters are saved automatically. All ion trap and FT 
calibration parameters are stored in the calibration file master.LTQCal, which 
is located in the folder:

C:\Xcalibur\system\ltq\msx

Backup Current
Calibration

It is possible to create a backup of the current calibration file manually or by 
choosing File > Backup Current Calibration in the Tune Plus window. 
The Backup Current Calibration and Restore Backup Calibration items 
work by copying the master.LTQCal to user.LTQCal and vice versa.

If a backup calibration user.LTQCal was already generated, the old 
user.LTQCal will be backed-up to a file named userXYZ.LTQCal. If you 
perform backup calibrations at regular intervals, then a history of your 
calibration files is generated in the folder:

C:\Xcalibur\system\ltq\msx

Using the Backup Calibration command regularly allows to return to 
previous calibrations in case a new calibration is suspected to worsen 
instrument performance. 

Restore Backup
Calibration

Upon Restore Backup Calibration, the calibration values saved in 
user.LTQCal are automatically downloaded to the instrument. Therefore, it 
is recommended to generate a current backup after a successful calibration. 

It is also recommended to use the Restore Backup Calibration command 
instead of the Restore Factory Calibration command since the backup 
calibration file is newer than the factory calibration file.
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Calibration Solutions This section provides information about preparing the calibration solutions 
for the LTQ Orbitrap.

LTQ Calibration Solution The LTQ calibration solution consists of caffeine, MRFA, and 
Ultramark 1621 in an acetonitrile:methanol:water solution containing 1% 
acetic acid.

Note Vials of caffeine, MRFA, and Ultramark 1621 are included in the 
API accessory kit. To order more of these compounds, write or call:

Sigma Chemical Company
P. O. Box 14508
St. Louis, Missouri, USA 63178-9916
Phone (800) 325-3010 (in the USA or Canada)

(314) 771-3750 (outside the USA or Canada) ▲

Caution  AVOID EXPOSURE TO POTENTIALLY HARMFUL 
MATERIALS.

Always wear protective gloves and safety glasses when you handle solvents or 
corrosives. Also contain waste streams and use proper ventilation. Refer to 
your supplier's Material Safety Data Sheet (MSDS) for proper handling of a 
particular solvent. ▲

To prepare the LTQ calibration solution, use the following procedure:

1. Stock Solution: MRFA

Prepare a 1.5 mL stock solution of 166.7 pmol/µL MRFA in 50:50 
methanol:water as follows:

a. Obtain the vial of L-methionyl-arginyl-phenylalanyl-alanine 
acetate × H2O (MRFA) in your accessory kit. In this form, the 
MRFA sample has an average molecular weight of 607.7 u. 
Carefully weigh 3.0 mg of the MRFA sample.

b. Dissolve the MRFA sample in a total volume of 1.0 mL of 50:50 
methanol:water. Mix the solution (5.0 nmol/µL) thoroughly.

c. Transfer 50 µL of the 5 nmol/µL solution into a clean polypropylene 
tube.

d. Add 1.45 mL of 50:50 methanol:water to the tube. Mix this 
solution (166.7 pmol/µL) thoroughly.
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e. Label the tube MRFA stock solution and store it in a refrigerator until 
it is needed.

2. Ultramark 1621 stock solution

Prepare a 10 mL stock solution of 0.1% Ultramark 1621 in acetonitrile 
as follows:

a. Obtain the vial of Ultramark 1621 in your accessory kit.

b. Using a syringe, measure out 10 µL of Ultramark 1621, and dissolve 
it in 10 mL of acetonitrile. Mix the solution thoroughly.

c. Label the vial Ultramark 1621 stock solution and store it in a 
refrigerator until it is needed.

3. LTQ calibration solution

Prepare 10 mL of the LTQ calibration solution as follows:

a. Obtain the 1 mg/mL stock solution of caffeine in 100% methanol 
that is provided in your accessory kit.

b. Pipet 200 µL of the caffeine stock solution into a clean, dry 10 mL 
volumetric flask.

c. Pipet 100 µL of the MRFA stock solution into the flask.

d. Pipet 100 µL of the Ultramark 1621 stock solution into the flask.

e. Pipet 100 µL of glacial acetic acid into the flask. 

Note Use only glass pipets or stainless steel syringes when measuring glacial 
acetic acid. Using plastic pipet tips causes contamination of acid stock 
solutions that can introduce contaminants into the calibration solution. ▲

f. Pipet 5 mL of acetonitrile into the flask.

g. Bring the volume of the solution up to the 10 mL-mark on the flask 
with 50:50 methanol:water.

h. Mix the calibration solution thoroughly.

i. Transfer the solution to a clean, dry vial.

j. Label the vial LTQ Calibration Solution and store it in a refrigerator 
until it is needed.
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LTQ Orbitrap Calibration
Solution

In contrast to the ion trap calibration, the FT calibration of the 
LTQ Orbitrap requires both positive and negative ions. The LTQ ESI 
calibration solution does not provide applicable negative ions below m/z 
1000. Thus, sodium dodecyl sulfate (gives anion at m/z 265) and sodium 
taurocholate (gives anion at m/z 514) is added to the LTQ ESI calibration 
solution to generate the LTQ Orbitrap calibration solution. In addition, the 
ratio of MRFA is increased versus the LTQ calibration solution.

Note Vials of sodium dodecyl sulfate and sodium taurocholate are shipped 
with the instrument. Refer to the Material Safety Data Sheet (MSDS) for 
proper handling of these substances. To order more of these compounds, 
contact Sigma-Aldrich. The product number of sodium dodecyl sulfate is 
L4509-10G, the product number of sodium taurocholate is 
T4009-250MG. Note that sodium dodecyl sulfate and sodium taurocholate 
are not included in the standard LTQ API accessory kit. ▲

Caution  AVOID EXPOSURE TO POTENTIALLY HARMFUL 
MATERIALS.

Always wear protective gloves and safety glasses when you use solvents or 
corrosives. Also, contain waste streams, and use proper ventilation. Refer to 
your supplier's Material Safety Data Sheet (MSDS) for proper handling of a 
particular solvent. ▲

To prepare the LTQ Orbitrap calibration solution, use the following 
procedure:

1. Stock Solution: Sodium Dodecyl Sulfate

a. Obtain the vial of sodium dodecyl sulfate. In this form the sample 
has an average molecular weight of 288.4 u. 

b. Prepare the stock solution of sodium dodecyl sulfate by dissolving 
2.88 mg in 10 mL of 50:50 methanol:water.

c. Mix the solution (1.0 nmol/µL) thoroughly. 

d. Label the vial Sodium Dodecyl Sulfate stock solution (1 nmol/µL).

2. Stock Solution: Sodium Taurocholate

a. Obtain the vial of sodium taurocholate. In this form the sample has 
an average molecular weight of 537.7 u.

b. Prepare the stock solution of sodium dodecyl sulfate by dissolving 
5.38 mg in 10 mL of 50:50 methanol:water.
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c. Mix the solution (1.0 nmol/µL) thoroughly.

d. Label the vial Sodium Taurocholate stock solution (1 nmol/µL).

3. Stock Solution: MRFA

To prepare the MRFA stock solution (5.0 nmol/µL or 166.7 pmol/µL 
in 50:50 methanol:water), refer to step 1 of topic ”LTQ Calibration 
Solution” above.

4. LTQ Orbitrap Calibration Solution

Prepare 10 mL of the LTQ Orbitrap calibration solution, as follows:

a. Pipet 10 mL of the standard LTQ ESI calibration solution into a 
vial.

b. Add 100 µL of the Sodium Dodecyl Sulfate stock solution.

c. Add 100 µL of the Sodium Taurocholate stock solution.

d. Add 6.6 µL of the 5.0 nmol/µL MRFA stock solution or 200 µL of 
the 166.7 pmol/µL MRFA stock solution, respectively.

e. Mix the solution thoroughly.

f. Label the vial LTQ Orbitrap calibration solution and store it in a 
refrigerator until it is needed.

Applicable Calibration
Solutions for Automatic

Calibration

In an automatic calibration of the LTQ Orbitrap, both the ion trap and the 
FT calibrations (positive and negative ion mode) are performed. Thus for 
an automatic calibration, the LTQ Orbitrap calibration solution has to be 
used.

Applicable Calibration
Solutions for

Semi-Automatic
Calibration

For the ion trap calibrations, the LTQ ESI calibration solution or the 
LTQ Orbitrap calibration solution can be used. For the FT calibrations of 
the positive ion mode, the LTQ ESI calibration solution or the 
LTQ Orbitrap calibration solution can be used. For the FT calibrations of 
the negative ion mode, the LTQ Orbitrap calibration solution has to be 
used. Thus, for a complete FT calibration the LTQ Orbitrap calibration has 
to be used, too.
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Applicable Calibration
Solutions for FT Manual

Calibration

Since the FT Manual Calibration page allows using your own calibration 
masses, it is possible to use custom calibration solution here. However, there 
are some requirements for the calibration masses. The scan ranges of the 
instrument need to be covered properly by the given masses.
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Calibration and
Tuning of the Ion Trap

This chapter describes the calibration and tuning of the ion trap for FT 
measurements. It contains the following topics:

• Calibration of the Ion Trap

• Tuning the Ion Trap for Positive Ion Mode

• Tuning the Ion Trap for Negative Ion Mode

Calibration of the Ion Trap To perform an FT calibration, the ion trap has to be successfully calibrated 
before. It is very important that the electron multiplier gain is correctly 
calibrated since the AGC prescan is performed in the ion trap. Thus, the 
electron multiplier gain calibration should be checked before an FT 
calibration is performed.

Note It is not necessary to use the ESI standard solution to perform a 
multiplier gain calibration. It is sufficient to use an MRFA solution (for 
example 5×10-6 M in 100% methanol, 1% acetic acid). ▲

For the ion trap calibrations, the LTQ ESI calibration solution or the 
LTQ Orbitrap calibration solution can be used.

Tuning the Ion Trap for
Positive Ion Mode

For the positive ion mode, it is recommended to perform an automatic tune 
of m/z 524 at a Full MS Target of 1e4–3e4. Use the LTQ ESI calibration 
solution or the LTQ Orbitrap calibration solution with the following 
settings in the Define Scan dialog box. See Figure 3-1 on page 3-10.
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After the automatic tune, a manual adjustment of the tube lens should be 
used to get an ion trap spectrum in the scan range 130–2000. 

The spectrum should look similar to the spectrum shown in Figure 3-2 on 
page 3-11. Make sure the peaks at 138, 195, 524, and the highest Ultramark 
peaks are all present, ideally above 30% of the base peak.

Note The peak at m/z 138 should have a height of more than 10%. Run an 
automatic ion trap tune on 138 if this signal is too weak. ▲

The inject time should be stable and less than 1 ms (if a Full MS target of 
1e4 is used). Do not forget to save the tune method after a successful tuning.

Figure 3-1. Recommended settings in the Define Scan dialog box for an automatic tune of the ion trap
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Tuning the Ion Trap for
Negative Ion Mode

For the negative ion mode, it is recommended to perform an automatic 
tune of m/z 514 at a Full MS Target of 1e4–3e4. Use the LTQ Orbitrap 
calibration solution with the settings shown in Figure 3-1 on page 3-10.

After the automatic tune, a manual adjustment of the tube lens should be 
used to get an ion trap spectrum in the scan range 150–2000. At m/z 265 is 
the base peak (100%) and the highest Ultramark adduct ion peaks are at 
about 80%, as shown in Figure 3-3 on page 3-12. 

If the tube lens is set to a very high negative voltage, in-source 
fragmentation of the Ultramark adduct ions may occur. Thus, if you 
observe rather ions at m/z 906, 1006, … than ions at m/z 1280, 1380, … 
the tube lens setting has to be decreased. The inject time should be stable 
and less than 1 ms (if a target of 1e4 is used). Do not forget to save the tune 
method after a successful tuning.

Figure 3-2. Ion trap spectrum of the LTQ Orbitrap calibration solution, scan range 120–2000, positive ion polarity mode
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Figure 3-3. Ion trap spectrum of the LTQ Orbitrap calibration solution, scan range 150–2000, negative ion mode
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Automatic Calibration
Tab

The Automatic tab of the Calibrate dialog box (see Figure 3-4) allows you 
to perform an automatic calibration of all the calibration parameters 
including all ion trap calibrations and all FT calibrations.

In an automatic calibration, these four FT calibration procedures are 
performed automatically one after another subsequent to the ion trap 
calibration. To perform an automatic calibration, the LTQ Orbitrap 
calibration solution has to be used.

The calibration masses and all experimental parameters like target values, 
scan ranges, resolution settings, etc. are set automatically and cannot be 
influenced by the user. 

Figure 3-4. Automatic tab of the Calibrate dialog box
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Note Usually you do not need to perform a complete ion trap calibration or 
an FT ion transmission calibration unless the hardware is modified in some 
way. However, it is necessary to repeat the electron multiplier calibration 
and the FT mass calibration on a regular basis. Thus, in the most cases it is 
not recommended to perform an automatic calibration of the LTQ Orbitrap 
since all calibrations are performed which takes about 1 hour. To run a 
multiplier gain calibration or an FT mass calibration (which takes only some 
minutes), it is recommended to use the semiautomatic calibration. ▲

Semi-Automatic
Calibration Tab

The Semi-Automatic tab of the Calibrate dialog box (see Figure 3-5) allows 
you to select specific calibration parameters to calibrate, for example only 
the ion trap calibrations or only the FT calibrations. For FT calibrations, it 
is also possible to differentiate between positive and negative ion mode.

Figure 3-5. Semi-Automatic tab of the Calibrate dialog box
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To calibrate one or more selected parameters, clear the Select All check box 
to make the individual calibration parameters available. Select the 
parameter(s) you want to calibrate, then click on Start.

For example:

• To run a complete automatic calibration (ion trap and FT), tick the 
Select All check box. Then, click on Start. This is analogous to the 
automatic calibration. As already described before it is not 
recommended to perform an automatic calibration of the 
LTQ Orbitrap if not necessary since all calibrations are performed 
which takes about 1 hour.

• To run an automatic calibration of the ion trap, tick the Select All - Ion 
Trap check box. Then, click on Start.

• To run an automatic calibration of the FT part, tick the Select All - FT 
check box. Then, click on Start.

• To run a FT mass calibration, tick the Mass Calibration check box. 
Then, click on Start.

In a semi-automatic calibration, the selected FT calibration procedure(s) are 
performed automatically one after another. 

All calibrations apart from the FT calibrations for the negative ion mode 
can be performed with the LTQ ESI calibration solution or with the 
LTQ Orbitrap calibration solution. To run the FT ion transmission and/or 
mass calibration for the negative ion mode, the LTQ Orbitrap calibration 
solution has to be used. 

The calibration masses and all experimental parameters like target values, 
scan ranges, resolution settings, inject waveforms etc. are set automatically 
and cannot be influenced by the user.
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Check Calibration
Page

The Check page of the Calibrate dialog box allows you to automatically 
check several calibration settings. See Figure 3-6. 

All calibration checks apart from those for the FT negative ion mode can be 
performed with the LTQ Orbitrap calibration solution or the LTQ ESI 
calibration solution. To check the FT calibrations in the negative ion mode, 
the LTQ Orbitrap calibration solution has to be used.

The calibration masses and all experimental parameters like target values, 
scan ranges, resolution settings, etc. are set automatically.

At the conclusion of the check procedure, the LTQ MS detector displays a 
message that indicates whether the parameter(s) are calibrated properly or 
not.

Figure 3-6. Check page of the Calibrate dialog box
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Using the Check page of the Calibrate dialog box, you can select the 
following parameters:

Select All This check box allows you to specify whether or 
not to check all of the calibration parameters. To 
check all calibration parameters, select the Select 
All check box. In this case, all ion trap calibration 
parameters and all FT calibration parameters are 
checked. You can also check each calibration 
parameter individually. To make the individual 
calibration parameters available, clear the Select 
All check box.

Select All Ion Trap This check box allows you to specify whether or 
not to check the calibration of the linear ion trap 
parameters only.

Select All-FT This check box allows you to specify whether or 
not to check the calibration of the Orbitrap ion 
transfer optics and mass analyzer only.

Transfer Multipole RF 
Frequency

This check box allows you to specify whether or 
not to check the frequency of the RF voltage of 
the transfer multipole in the FT transfer ion 
optics.

Storage Multipole RF 
Frequency

This check box allows you to specify whether or 
not to check the frequency of the RF voltage of 
the storage multipole in the FT transfer ion 
optics. 

Positive Ion Mode This check box allows you to specify whether or 
not to check the FT ion transmission calibration 
and FT mass calibration for the positive ion 
mode.

Negative Ion Mode This check box allows you to specify whether or 
not to check the FT ion transmission calibration 
and FT mass calibration for the negative ion 
mode.
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The Last Check Date readback column gives the date of the last successful 
check for each item. If a check is performed that fails, the last successful 
check date still appears in the Last Check Date readback column. The last 
successful check continues to be in effect in the instrument. However, the 
result column will show a red x mark indicating that the current attempt 
check has failed or was aborted.

Storage Transmission This check box allows you to specify whether or 
not to check the ion storage transmission 
calibration. The storage transmission is checked 
by transferring ions form the ion trap to the ion 
storage device and backward, then scanning in 
the ion trap. The FT storage transmission 
calibration can be checked for the positive and 
negative ion mode independently.

FT Transmission This check box allows you to specify whether or 
not to check the FT ion transmission calibration. 
The ion transmission from the ion trap to the 
Orbitrap is checked by means of the calibration 
masses in SIM experiments at different AGC 
target values. The FT transmission calibration 
can be checked for the positive and negative ion 
mode independently.

Mass Calibration This check box allows you to specify whether or 
not to check the mass calibration of the Orbitrap 
mass analyzer. In this check, the current mass 
calibration is checked, i.e it is a check of the 
external mass calibration. The FT mass 
calibration can be checked for the positive and 
negative ion mode independently.
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FT Manual Calibration
Page

The FT Manual page of the Calibrate dialog box allows to perform or to 
check an FT transmission calibration, storage transmission calibration, and 
an FT mass calibration with user-defined calibration masses. See Figure 3-7. 

Note Starting from the FT Manual Page, the calibration is performed for 
the currently selected polarity only. ▲

Figure 3-7. FT Manual page of the Calibrate dialog box
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Mass List Group Box The calibration masses for the manual calibration can be defined in the 
corresponding mass list on the FT Manual page of the Calibration dialog 
box. Mass lists can be imported and exported by means of the Instrument 
Configuration page, see further details in Chapter 6: “Instrument 
Configuration”.

Note Ensure that you use calibration masses of sufficient accuracy (sub 
ppm). ▲

Factory-Supplied Mass Lists There are also two factory supplied mass lists, calmix_positive (factory) and 
calmix_negative (factory). They contain the exact masses of all main ion 
peaks, which should appear if the LTQ Orbitrap calibration solution is used 
in positive or negative ion mode, respectively. 

Name This list box lists the names of the factory supplied and user 
created mass lists. 

Mass List This table lists the mass-to-charge ratios of the ions that you 
are using to calibrate the Orbitrap mass analyzer. You can 
select an existing mass list in the Name list box, or you can 
create or modify a mass list by clicking on and editing the 
entries in the Mass List table. 

Note Ensure that you use calibration masses of sufficient 
accuracy (sub ppm). ▲

Save Click on Save to save the mass list with the name that is 
selected in the Name list box.

Save As Click on Save As a to save the mass list with a new name.

Delete Click on Delete to delete the mass list that is selected in the 
Name list box.
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Chapter 4 Performing 
Diagnostics/Checks

This chapter describes several diagnostic procedures for the LTQ Orbitrap. 
It contains the following topics:

• “System Evaluation Procedures” on page 4-2

• “Toggles” on page 4-6

• “Set Device” on page 4-9

• “Display Settings” on page 4-11
Thermo Fisher Scientific LTQ Orbitrap Getting Started 4-1



Performing Diagnostics/Checks
System Evaluation Procedures
System Evaluation
Procedures

The System Evaluation page in the Diagnostics dialog box allows you to 
evaluate system performance. See Figure 4-1.

Besides several ion trap relevant system evaluation procedures, you can 
perform the following FT system evaluation procedures:

• “FT Temperature Monitor” on page 4-3

• “FT Temperature Control Evaluation” on page 4-3

• “FT Preamp Evaluation” on page 4-3

• “FT Sensitivity Test” on page 4-3

• “FT Noise Test” on page 4-4

• “FT Isolation Test” on page 4-4

• “FT Dynamic Range Test” on page 4-4

• “FT Stability Test” on page 4-4

• “FT High Mass Range Target Compensation” on page 4-5

Figure 4-1. System evaluation page of the Diagnostics dialog box
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Performing Diagnostics/Checks
System Evaluation Procedures
FT Temperature Monitor External mass accuracy of the Orbitrap detector depends on a stable 
temperature of the analyzer and the electronic components. This evaluation 
plots a history of the temperature regulation results to the graph view, see 
“Graph View” on page 2-5.

FT Temperature Control
Evaluation

This evaluation procedure allows examining temperature regulation 
behavior of the instrument by intentionally driving temperatures to extreme 
values. 

Note The evaluation will usually take more than 12 hours where no 
measurements can be done. After stopping the evaluation, the instrument 
needs to stabilize temperatures for several hours before high mass accuracy 
measurements can be started. ▲ 

FT Preamp Evaluation This evaluation allows checking the basic FTMS analyzer signal detection 
path. The instrument needs to run in FTMS analyzer mode. It is 
recommended to switch to diagnostic transient view, see “FT Include 
Transients” on page 4-7.

During the evaluation, the preamp input protection switches are activated 
with a period of 100 ms. This switching can be observed as periodic 
incidences in the transient if the electronic signal path is operational. 

FT Sensitivity Test The FT sensitivity test is only applicable for an infusion experiment with 
Reserpine. The test assumes that a Reserpine solution of 5×10-9 M 
(100% methanol, 1% acetic acid) is used. The following test are performed 
one after another:

1. SIM of m/z 609.28 using the ion trap as analyzer and an AGC target of 
2e+03. 

2. SIM of m/z 609.28 using the orbitrap detector as analyzer and an AGC 
target of 5e+03.

3. SIM of m/z 609.28 using the orbitrap detector as analyzer and an AGC 
target of 5e+04.

4. MS/MS of m/z 609.28 using the orbitrap detector and an AGC target 
of 5e+04.
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Performing Diagnostics/Checks
System Evaluation Procedures
The test fails

a. if the inject time which is necessary to reach the selected AGC target 
value is too high. 

b. if the ratio of the reserpine signal to the overall signal inside the 
SIM window is too low 

c. if the transmission from the ion trap to the orbitrap detector is too 
low or 

d. if the intensity of the product ions of reserpine is too low.

FT Noise Test This test determines resistant noise peaks in the selected scan range. In this 
test ions are “switched off ” automatically. At the conclusion of the FT noise 
test, a list of resistant noise peaks is displayed in the Testing text.

FT Isolation Test This test is only applicable for an infusion experiment with a solution 
containing MRFA, for example the standard LTQ calibration solution or a 
MRFA alone solution (for example 5×10-6 M in 100% methanol/water, 
1% acetic acid). This test is analogous to the “Check of the ion isolation 
waveform” on the Check page of the Calibrate dialog box. Here, the 
isolation of m/z 525.3 is performed at a target of 2000 and analyzed by the 
ion trap. In contrast to this, the FT isolation test is performed at higher 
targets and uses the FT analyzer. Thus this test determines the maximum 
AGC target value that allows performing a unit isolation of m/z 525.3 at the 
presence of m/z 524.3 and 526.3.

FT Dynamic Range Test This test is only applicable for an infusion experiment with a solution 
containing MRFA, for example the standard LTQ calibration solution or a 
MRFA alone solution (for example 5×10-6 M in 100% methanol/water, 
1% acetic acid). This test determines the signal-to-noise ratio of an isolated 
MRFA signal.

FT Stability Test This test is applicable for an infusion experiment with any sample solution. 
This test procedure checks the stability of the FT TIC (total ion current) 
detected in the selected scan range by means of 600 scans. In principle, the 
test can be performed at any experimental conditions. It is recommended, 
however, to perform this test in Full scan mode using one microscan, a 
resolution setting of 60000 and a FT Full MS Target of 5e+05 or 1e+06. At 
the conclusion of the FT stability test, the AGC stability and the 
corresponding signal variation is displayed.
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Performing Diagnostics/Checks
System Evaluation Procedures
FT High Mass Range
Target Compensation

This procedure determines an AGC target compensation factor, which 
ensures that the FT mass calibration is still valid if the instrument is set into 
the high mass range mode. The resulting compensation factor will be saved 
in the calibration file. Usually, it is sufficient to run this procedure once. It is 
not necessary to repeat this procedure on a regular basis. It is recommended 
to use the LTQ calibration solution for this test. However, you can also use 
any other solution that gives reasonable ion signals at 1000 < m/z < 2000.

Figure 4-2. Result of the FT stability test displayed in the Graph View
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Performing Diagnostics/Checks
Toggles
Toggles The Toggles page in the Diagnostics dialog box allows you to toggle 
[change] a subsystem from one state to another state. See Figure 4-3.

To display this page: 

From the Tune Plus window, choose Diagnostics > Diagnostics > Tools > 
Toggles.

Caution  All toggles should only be used for diagnostic purposes. The 
functionality of the LTQ Orbitrap may be harmed if a toggle is switched to 
a status which differs from its default value. ▲

If one of the FT toggles is (accidentally) different from its default value 
during data acquisition, the FT Analyzer Settings of the Scan Header of a 
raw file contains a reference to this. See Appendix A: “Miscellaneous 
Information” for further details.

Figure 4-3. Toggles page of the Diagnostics dialog box
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Performing Diagnostics/Checks
Toggles
Note The status of a toggle is not saved in the tune method and is set back 
to its default value after an instrument reset. The toggle state shown by the 
radio buttons next to the list box does not necessarily correspond to the 
actual settings. ▲

FT Analyzer Ion Gauge With this toggle, the ion gauge for the FT analyzer vacuum can be disabled 
manually for diagnostic purposes. The default setting is enabled.

FT Analyzer Temperature
Control

With this toggle, the FT analyzer temperature control regulation electronics 
can be disabled for diagnostic purposes. The default setting is enabled. 

FT Apodization With this toggle, the apodization can be switched on or off. The default 
setting is On.

FT Include Transients If this toggle is on, it is possible to display transients in the Spectrum View 
by choosing Show FT Transient in the shortcut menu of the Spectrum 
View. The menu is displayed when you right-click anywhere on that page. 
See topic “Spectrum View” on page 2-3 for further details. 

Note A transient view is only possible if profile (instead of centroid) is 
chosen as data format. ▲

During transient display in Spectrum View, the x-coordinate is misleadingly 
labeled with m/z instead of milliseconds. The default setting is Off.

Note It is not possible to acquire transients into an Xcalibur raw file. ▲

FT Storage Multipole RF This toggle can be used to switch the FT storage multipole RF on or off. 
The default setting is On. If the multipole RF is switched on, the 
corresponding blue diagnostic LED of the ion optic supply board should be 
on (indicating that the RF1 generator is switched on). See the LTQ Orbitrap 
Hardware Manual  for further details.

FT Transfer Multipole RF This toggle can be used to switch the FT transfer multipole RF on or off. 
The default setting is On. If the multipole RF is switched on, the 
corresponding blue diagnostic LED of the ion optic supply board should be 
on (indicating that the RF2 generator is switched on). See the LTQ Orbitrap 
Hardware Manual  for further details.
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Performing Diagnostics/Checks
Toggles
FT Manual Calibration for
Single Range

This toggle can be used to influence the behavior of the FT manual 
calibration procedures, refer to “FT Manual Calibration Page” on 
page 3-19. In the default behavior, the FT manual calibration procedures 
calibrate the whole scan mass range for the actual polarity.

In order to be able to use nonstandard calibration substances that cover a 
limited mass range only, advanced users may enable this toggle. With this 
toggle enabled, there is no check for mass range coverage of reference mass 
lists. Instead, the instrument stays in the chosen mass range and calibrates 
this range only. With this toggle enabled, the user is responsible to cover the 
whole mass range needed, possibly by calibrating manually in several steps 
with different substances. If the performed FT manual calibration is not 
suitable for the scan settings used in an FTMS analyzer data acquisition, the 
scan header of a raw data file contains a reference to this. See Chapter A: 
“Miscellaneous Information” for further details.

FT Profile Mode With this toggle you can select whether the FT profile mode corresponds to 
a Full Profile format or to a Reduced Profile format. It is recommended to 
use the Reduced Profile Mode for data acquisition since the data size of the 
raw file is significantly decreased by using the Reduced Profile. The default 
setting is Reduced. For further information, see also topic “Data Size of FT 
Raw Files” on page A-4. 

FT SIM and MSn Injection
Waveforms

Usually, for FT SIM and FT MSn scans, the injection waveforms are 
automatically enabled. It is not possible to change this setting in the 
Injection Control dialog box. By means of this toggle, it is possible to 
disable or enable the injection waveforms manually for diagnostic purposes. 
The default setting is On. 

FT View Frequency If this toggle is switched on, the FT spectrum is shown as a frequency 
spectrum. If the system is on and the FT is chosen as analyzer, the frequency 
spectrum is displayed in the spectrum view. The default setting is Off.

Note The x-coordinate is misleadingly labeled with m/z instead of kHz. ▲

This toggle is for diagnostic purposes only. Therefore, it is not possible to 
acquire frequency spectra.

FT Zero Offset If this toggle is switched on, an offset is added to the spectrum. This enables 
to view the full noise band. The default setting is Off, if the Reduced Profile 
format is used. The setting is On, if the Full Profile format is used.
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Performing Diagnostics/Checks
Set Device
Set Device The Set device page of the Diagnostics dialog box (Figure 4-4) allows to 
select devices or experimental parameters from the list and to set the value 
for that device or parameter. To set a device:

1. Select the device or parameter you would like to set from the Device list 
box.

2. Enter the device parameter's value in the text box below the Device list 
box.

3. Click on Set to apply the change to the device value or parameter.

Note The value in the text box below the Device list box, which is displayed 
after the call of this page, does not necessarily correspond to the actual 
value. ▲

There are several FT relevant parameters, which may be changed from this 
page. 

Figure 4-4. Set device page of the Diagnostics dialog box
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Performing Diagnostics/Checks
Set Device
Note After an instrument reset the manual settings are overwritten with the 
corresponding calibration parameters. ▲

Caution  Changing the instrument settings can harm the functionality of the 
LTQ Orbitrap, especially if followed by saving the calibration parameters 
(manually or at conclusion of a calibration procedure). Thus, this option 
should only be used by very advanced users. ▲

FT Lockmass Abundance This device allows changing the target value of an injected lock mass relative 
to the actual FT scan target value. The recommended default is 10 percent. 
Also refer to “Locking” on page 2-10.

FT Mass Check Test
Duration

This device allows changing the duration of FT Manual mass calibration 
checks, see “FT Manual Calibration Page” on page 3-19. By changing this 
value, a long-term mass stability evaluation can be run. The default behavior 
of the FT manual mass calibration check is to perform 100 scans checking 
the mass accuracy. The test duration may be extended to up to 72 hours. 
The default behavior can be restored by setting the duration to zero. If the 
duration is set between two and 24 hours, the FT manual mass calibration 
check will specially control the syringe pump in order to allow running 
long-term test with a single syringe filling. For durations above 24 hours, it 
is assumed that an external syringe pump is used.

Setting new FT Transfer
Optics Parameters

There are two set device items that can be used to override the FT optics 
values. These values are originally determined during instrument calibration 
and set automatically. Overriding calibration values will influence 
instrument performance and should only be done for diagnostic purposes. 

Note If you have changed FT transfer optics settings, it is recommended to 
perform a full FT instrument calibration afterwards to assure good 
instrument performance. ▲
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Performing Diagnostics/Checks
Display Settings
Display Settings The Display Settings page in the Diagnostics dialog box allows you to select 
a variety of instrument settings for display:

1. Select the instrument settings you want to display, 

2. Click on Start, 

3. The LTQ Orbitrap MS detector now displays the requested instrument 
settings in the Testing text box.

The following FT relevant instrument settings can be displayed:

• FT calibration settings

• FT diagnostics

• FT instrument settings

Figure 4-5. Display settings page of the Diagnostics dialog box
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Display Settings
Display FT Calibration
Settings

Displays all FT relevant calibration parameters in the diagnostics text box.

Display FT Diagnostics Displays current diagnostic readback values of the FT electronic boards.

Display FT Instrument
Settings

Displays the current values of those FT instrument settings which depend 
on the scan range and ion polarity mode and can be changed manually on 
the Set Device page of the Diagnostics dialog box.
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Chapter 5 Instrument Setup

This chapter takes a look at the “Locking” feature in automated runs and 
describes the FT relevant topics of the data dependent settings in the 
Instrument Setup. It contains the following topics:

• “Using Locking in Automated Runs” on page 5-2

• “Data Dependent Settings” on page 5-3
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Using Locking in Automated Runs
Using Locking in
Automated Runs

In order to use locking in an automated run, use the Instrument Setup 
program. 

Note Refer to topic “Locking” on page 2-10 for a basic description on using 
locking with FTMS analyzer scans. ▲

The Lock Mass List button in the segment settings group brings up a lock 
mass list editor dialog. Segment-related lock masses can be entered here. 
There are separate lists for positive ion and negative ion mode. If the lock 
mass for a segment is empty, no locking will be applied in the run and the 
external calibration will be used.

Figure 5-1. MS Detector setup dialog
5-2 LTQ Orbitrap Getting Started Thermo Fisher Scientific



Instrument Setup
Data Dependent Settings
Data Dependent
Settings

This section describes the FT relevant topics of the data dependent settings 
in the Instrument Setup.

Preview Mode Figure 5-2 shows the Current Segment page of the Data Dependent 
Settings dialog box.

If the preview mode for FTMS master scans is enabled on the Current 
Segment page, the data dependent decision is made on the basis of the 
FTmaster scan with lower resolution to increase the duty cycle. The 
resolution of the FTMS scan itself is not changed. Since the high resolution 
is usually not required to make the data dependent decision, it is 
recommended to enable the preview mode. 

To prevent making data dependent decisions on basis of lower-resolution 
preview spectra, disable this option. For example, if there are ions with high 
charge states to be examined, and the data dependent settings require charge 
state recognition of precursor ions, this might be a reason to turn off this 
option. Otherwise, the high charge state clusters may not be resolved and 
charge states will not recognized in preview mode.

Figure 5-2. Data Dependent Settings dialog box – Current Segment page
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Data Dependent Settings
Monoisotopic Precursor
Selection

Figure 5-3 shows Charge State page of the Data dependent settings dialog 
box.

If the monoisotopic precursor selection is enabled on the Charge State page, 
the data dependent scan is only performed for one molecular ion of the 
corresponding overall 13C isotopic distribution if Dynamic Exclusion is 
enabled. 

This check box is only available on the Charge State page if the Advanced 
Features are turned on in the LTQ menu of the Instrument Setup.

Use Non-Peptide
Monoisotopic Recognition

This check box is only available if monoisotopic precursor selection is active. 
If monoisotopic precursor selection is active and this box is not checked, 
precursor ions in FT master scans must match peptide-type isotopic 
distribution in order to identify the monoisotopic peak. If this box is 
checked, monoisotopic peaks will also be identified for small molecules and 
precursor ions with non-peptide-type isotopic distributions.

Figure 5-3. Charge State page of the Data dependent settings dialog box with 
Advanced Features on
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Data Dependent Settings
Data Dependent FT SIM
Scans

A data dependent FT SIM scan is performed around the center mass 
determined in a previous reference scan event if the check box “Same 
MS order as referenced scan event” is selected on the Current Scan Event 
page of the Data Dependent Settings dialog box as shown in Figure 5-4. 

The scan width of the data dependent FT SIM scan can be selected on the 
Scan widths page of the Data Dependent Settings dialog box. See 
Figure 5-5.

Figure 5-4. Data Dependent Settings dialog box – Current Scan Event page

Figure 5-5. Data Dependent Settings dialog box – Scan Widths page
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Chapter 6 Instrument Configuration

This chapter gives instructions on how to configure your instrument. It 
contains the following topics:

• “Starting Instrument Configuration” on page 6-2

• “FT Settings Page” on page 6-3

• “FT Mass Lists Page” on page 6-4
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Starting Instrument Configuration
Starting Instrument
Configuration

From the Instrument Configuration dialog box, click on the LTQ Orbitrap 
MS button in the Configured Devices group box. See Figure 6-1. Then, 
click on the Configure button to open the LTQ Configuration dialog box.

The LTQ Orbitrap Configuration dialog box allows you to enter 
LTQ Orbitrap configuration information by using several pages, including 
the FT Settings page and the FT Manual Calibration page.

The elements of the pages are described in the following topics.

Figure 6-1. Instrument Configuration dialog box
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FT Settings Page
FT Settings Page The FT Settings page of the LTQ Configuration dialog box allows you to 
turn on Active Noise Reduction. 

Using the FT Settings page of the LTQ Configuration dialog box, you can 
select the following parameters:

Note Configuration changes will become effective when you reboot your 
instrument. ▲

Figure 6-2. LTQ Configuration dialog box – FT Settings page

Active Noise 
Reduction

Select this check box to turn on Active Noise 
Reduction. If the Active Noise Reduction is turned on, 
an advanced algorithm is used to decrease the statistic 
noise in an FT spectrum without increasing the noise 
threshold. If the Active Noise Reduction is turned on 
the data size of acquired raw files is decreased.
For further information, see also topic “Data Size of 
FT Raw Files” on page A-4.

FTMS analyzer 
temperature 
setpoint (°C)

Enter the desired temperature for the Orbitrap 
analyzer chamber. The default value is 26.
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FT Mass Lists Page
FT Mass Lists Page The FT Mass Lists page of the LTQ Configuration dialog box allows you to 
manipulate the mass lists that are displayed in the FT Manual Calibration 
page of the Calibration dialog box in Tune Plus. See Figure 6-3. You can also 
import or export a mass list as a text file. 

Using the FT Mass Lists page of the LTQ Configuration dialog box, you can 
select the following parameters: 

Figure 6-3. FT Mass Lists page of the LTQ Configuration dialog box

Name This list box lists the names of the factory supplied 
and user created mass lists. 

Mass List This table lists the mass-to-charge ratios of the ions 
that you are using to calibrate the Orbitrap mass 
analyzer. You can select an existing mass list in the 
Name list box, or you can create or modify a mass list 
by clicking on and editing the entries in the Mass List 
table. 

Note Ensure that you use calibration masses of 
sufficient accuracy (sub ppm). ▲
6-4 LTQ Orbitrap Getting Started Thermo Fisher Scientific



Instrument Configuration
FT Mass Lists Page
Save Click on Save to save the mass list with the name that 
is selected in the Name list box.

Save As Click on Save As a to save the mass list with a new 
name.

Delete Click on Delete to delete the mass list that is selected 
in the Name list box.

Import Click on Import to import a mass list that is a text file.

Export Click on Export to export a mass list to a text file.

Show Factory Lists Select this check box if you want to show the factory 
calibration mass lists in Tune Plus. 
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Appendix A Miscellaneous Information

This appendix contains supplemental information for the previous chapters. 
It contains the following topics:

• “FT Analyzer Information in Scan Header” on page A-2

• “Data Size of FT Raw Files” on page A-4
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Miscellaneous Information
FT Analyzer Information in Scan Header
FT Analyzer
Information in Scan

Header

The Qual Browser window allows you to open a raw file and to display scan 
header information for a selected scan in any of the cells. Choose View > 
Scan Header to display the Scan Header of the current scan in the active 
cell.

FT Analyzer Settings The scan header information of an FT scan includes information about the 
FT Analyzer Settings, which is not available in the usual Reports (Tune 
method, Instrument method, Status log, or Error log):

T=1e5 AGC Target for this scan (here: 1e+05)

PsIT=0.65 Prescan Inject Time (here: 0.65)

Tog=(…) Manual diagnostic toggles are set different from 
their default values. See Table A-1 below for 
detailed information.

iWf Inject waveform on for this scan.

PvR=3e4 Preview analysis active for this scan 

DiagManualSettings Calibration parameters were manually changed 
under Diagnostics.

Table A-1. Actual settings of manual toggles

Tog = (…) Relevant Toggle Current setting Default setting

ApoOff FT apodization Off On

TrExp FT include transient On Off

FullP FT profile mode Full Reduced

IWFoff FT SIM and MSn injection 
waveforms 

Off On

Freq FT view frequency On Off 

Offset FT zero offset On Off
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FT Analyzer Information in Scan Header
FT Analyzer Messages The scan header of an FT scan includes also so-called FT Analyzer 
Messages:

Ufill=0.45 Maximum ion time reached. Here: the real 
number of ions is only ~45% of the target value.

MCal=4d Last mass calibration for this scan range is several 
days old (here: 4) 

Est=0x24 Machine-readable result message for 
post-processing tools

DAC=0.98 FT transient measurement near saturation, this 
might result in spectral harmonics (typically 
target value too high)

TCal=[195..] This is a hint that the current scan range settings 
for the FT analyzer are outside the calibrated 
storage/transfer mass range. Transfer parameters 
are extrapolated.

Lock=
(inj524.3,1/1,+3ppm)

Information about lock mass settings, extra 
SIM injection of lock mass ions, number of 
identified lock masses in the spectrum, and 
deviation of corrected (locked) masses compared 
to the external calibration.

Stable=15min Shows the elapsed stabilization time of the 
FTMS analyzer high voltage electronics after last 
off state or polarity switch. For best external mass 
accuracies, it is required to let the FTMS analyzer 
high voltage electronics stabilize before 
performing an acquisition or mass calibration.

TempDiff=1 There is a temperature difference in the 
FTMS analyzer temperature between mass 
calibration time and current state. This may be 
caused by setting a different analyzer temperature 
setpoint in instrument configuration, by rapid 
significant changes in the ambient temperature, 
or by not waiting for temperature stabilization 
after instrument (temperature regulation) was off.

PkOvf Internal Peak detection overflow in the FT 
spectrum analysis
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Data Size of FT Raw Files
Note The actual FT analyzer Messages can also be displayed in the Tune 
spectrum view, see “Spectrum View” on page 2-3. ▲

Data Size of FT Raw
Files

The data size of a raw file with FT data depends on many parameters, for 
example on the number of scans, the resolution setting, the data format and 
on the status of the Active Noise Reduction.

Table A-2 below displays typical data sizes (per scan) of an FT spectrum 
(standard LTQ Orbitrap calibration solution, scan range 120–1200, 
AGC target 5E5, 1 microscan, resolution setting 60000) at different 
FT data formats and with Active Noise Reduction off.

Table A-2. Typical data sizes (per scan) of an FT spectrum

FT Data Format Active Noise Reduction Typical data size / scan 

Centroid On ca. 10 kB

Reduced Profile On ca. 20 kB

Centroid Off ca. 35 kB

Reduced Profile Off ca. 80 kB

Full Profile On/Off ca. 2800 kB
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Glossary
The following abbreviations and terms are used in 
this manual. This glossary also includes acronyms, 
metric prefixes, symbols, and abbreviations.

A  ampere

ac  alternating current

ADC  analog-to-digital converter

AP  acquisition processor

APCI  atmospheric pressure chemical ionization

API  atmospheric pressure ionization

APPI  atmospheric pressure photo ionization

ASCII  American Standard Code for Information 
Interchange

b  bit

B  byte (8 b)

baud rate  data transmission speed in events per 
second

°C  degrees Celsius

cfm  cubic feet per minute

CI  chemical ionization

CIP  carriage and insurance paid to

cm  centimeter

cm3  cubic centimeter

CPU  central processing unit (of a computer)

CRC  cyclic redundancy check

CRM  consecutive reaction monitoring

<Ctrl>  control key on the terminal keyboard

d  depth

Da  dalton

DAC  digital-to-analog converter

dc  direct current

DDS  direct digital synthesizer

DS  data system

DSP  digital signal processor

EI  electron ionization

EMBL  European Molecular Biology Laboratory

<Enter>  Enter key on the terminal keyboard

ESD  electrostatic discharge

ESI  electrospray ionization

eV  electron volt

f  femto (10-15)

°F  degrees Fahrenheit

.fasta file  extension of a SEQUEST search database 
file
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Glossary: FOB
FOB  free on board

ft  foot

FFT  Fast Fourier Transformation

FT  Fourier Transformation

FTMS  Fourier Transformation Mass Spectroscopy

FTP  file transfer protocol

FWHM  full width at half maximum

g  gram

G  Gauss; giga (109)

GC  gas chromatograph; gas chromatography

GC/MS  gas chromatograph / mass spectrometer

GUI  graphical user interface

h  hour

h  height

HPLC  high-performance liquid chromatograph

HV  high voltage

Hz  hertz (cycles per second)

ICIS™  Interactive Chemical Information System

ICL™  Instrument Control Language™

ID  inside diameter

IEC  International Electrotechnical Commission

IEEE  Institute of Electrical and Electronics 
Engineers

in  inch

I/O  input/output

k  kilo (103, 1000)

K  kilo (210, 1024)

KEGG  Kyoto Encyclopedia of Genes and Genomes

kg  kilogram

l  length

L  liter

lb  pound

LC  liquid chromatograph; liquid chromatography

LC/MS  liquid chromatograph / mass spectrometer

LED  light-emitting diode

µ  micro (10-6)

m  meter

m  milli (10-3)

M  mega (106)

M+  molecular ion

MALDI  matrix-assisted laser desorption/ionization

MB  Megabyte (1048576 bytes)

MH+  protonated molecular ion

min  minute

mL  milliliter

mm  millimeter
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Glossary: MRFA
MRFA  A peptide with the amino acid sequence 
methionine–arginine–phenylalanine–alanine.

MS  mass spectrometer; mass spectrometry

MS  MSn power: where n = 1

MSDS  Material Safety Data Sheet

MS/MS  MSn power: where n = 2

MSn  MSn power: where n = 1 through 10

m/z  mass-to-charge ratio

n  nano (10-9)

NCBI  National Center for Biotechnology 
Information (USA)

NIST  National Institute of Standards and 
Technology (USA)

OD  outside diameter

OT  orbitrap

Ω  ohm

p  pico (10-12)

Pa  pascal

PCB  printed circuit board

P/N  part number

ppm  parts per million

RAM  random access memory

RF  radio frequency

RMS  root mean square

ROM  read-only memory

s  second

SIM  selected ion monitoring

SRM  selected reaction monitoring

SSQ™  single stage quadrupole

TCP/IP  transmission control protocol / Internet 
protocol

TIC  total ion current

Torr  torr

TSQ™  triple stage quadrupole

TWA  time weighted average

u  atomic mass unit

V  volt

V ac  volts alternating current

V dc  volts direct current

vol  volume

w  width

W  watt
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Index

A
Active Noise Reduction 6-3, A-4
actual settings, of manual toggles A-2
advanced scan features 2-8
AGC 2-9

stability 4-4
target compensation factor 4-5
target values 2-9–2-10, 2-14, 2-18

analyzer temperature control 4-7
analyzer type 2-8
analyzer vacuum 4-7
API accessory kit 3-4, 3-6
apodization 4-7
automated run 5-2
automatic calibration 3-2, 3-7, 3-13
automatic gain control (AGC) 2-14
Automatic tab 3-13
automatic tune, recommended settings 3-10

B
bakeout procedure 2-17

C
Calibrate dialog box 3-13–3-14

automatic calibration 3-13
check calibration 3-16
Check tab 3-16
FT manual calibration 3-19
FT Manual tab 3-19
Semi-Automatic tab 3-14

calibrating 3-13
FT Measurements 3-1

calibration
automatic 3-13
automatic check settings 3-16
calibration 3-13
FT manual calibration 3-19
ion trap 3-9
negative ion mode 3-17
positive ion mode 3-17
semi-automatic calibration 3-14

calibration checks 3-16

readback 3-18
calibration files

backups 3-3
content 4-5
history 3-3

calibration masses 3-8, 3-20
calibration parameters 3-2, 4-12
calibration procedures 3-2
calibration solutions 3-4

automatic calibration 3-7
FT manual calibration 3-8
semi-automatic calibration 3-7

calibration values 3-3
calmix_negative 3-20
calmix_positive 3-20
centroid format 2-11
centroid/profile format 2-11
changing instrument settings 4-10
Charge State page 5-4
charge states 5-3–5-4

peaks 2-4
recognition 5-3

Check page 3-16
checks

calibration 3-16
mass duration 4-10

compensation factor 4-5
compressed profile format 2-11
configuration changes 6-3
Current Scan Event page 5-5
current segment 5-3
Current Segment page 5-3

D
data dependent FT SIM scan 5-5
data dependent settings 5-3

charge state 5-4
current segment 5-3

data formats
storage 2-20
switching formats 2-11

define scan
analyzer type 2-8
inject time 2-9
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Index: E
locking feature 2-10
mass range 2-9
recommended settings for automatic ion trap tuning 3-10
resolution 2-9
scan rate 2-9
scan time 2-9
scan time settings 2-10
scan type 2-9

Define Scan dialog box 2-8, 3-10
diagnostic views 2-4
Diagnostics dialog box 4-1

Toggles page 4-6
Display FT calibration settings 4-12
Display FT diagnostics 4-12
Display FT instrument settings 4-12
Display menu 2-12
Display Settings page 4-11
Dynamic Exclusion 5-4
dynamic range 2-15

E
editing, lock mass lists 2-10
electron multiplier calibration 3-14
electron multiplier gain calibration 3-9
enable injection waveforms 2-15
external calibration 5-2
external mass accuracy 4-3

F
factory-supplied mass lists 3-20
frequency spectrum 4-8
FT analyzer 4-4

automatic calibration 3-15
information in scan header A-2
ion gauge 4-7
messages A-3
settings A-2
target values 2-15
temperature control 4-7

FT apodization 4-7
FT calibration 3-6

negative ion mode 3-7
positive ion mode 3-7
procedures 3-13

FT dynamic range test 4-4
FT include transients 4-7
FT injection waveforms 2-16
FT instrument calibration 4-10

FT instrument settings 4-12
FT isolation test 4-4
FT Lockmass Abundance 4-10
FT manual mass calibration checks 4-10
FT Manual page 3-2, 3-8, 3-19
FT mass calibration 3-2, 3-14, 3-18, 4-5

automatic calibration 3-15
FT Mass Check Test Duration 4-10
FT Mass Lists page 6-4
FT mass spectrum, resolution 2-9
FT MSn scans 4-8
FT noise test 4-4
FT Preamp Evaluation 4-3
FT profile mode 4-8
FT sensitivity test 4-3
FT Settings page 6-3
FT SIM 5-5

scans 4-8
FT SIM and MSn injection waveforms 4-8
FT stability test 4-4

result 4-5
FT storage multipole RF 4-7
FT storage transmission calibration 3-18
FT target values 2-15
FT Temperature Control Evaluation 4-3
FT Temperature Monitor 4-3

dialog box 2-17
icon 2-17

FT TIC 4-4
FT transfer multipole frequency calibration 2-5
FT transfer multipole RF 4-7
FT transfer optics 2-13
FT Transfer Optics dialog box 2-13
FT Transfer Optics icon 2-13
FT transfer parameters 2-13
FT transmission calibration 2-13, 3-2, 3-18
FT vacuum 2-16
FT view frequency 4-8
FT zero offset 4-8
FTMS analyzer

signal detection path 4-3
temperature regulation 2-17

Full MS target 2-15
full noise band 4-8
Full Profile format 4-8

G
glacial acetic acid 3-5
Graph view 2-5
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Index: H
H
high charge states 5-3
high mass range mode 4-5

I
infusion experiment 4-3–4-4
inject time 2-9, 3-11
inject waveform 2-19

flags 2-19
injection control

FT analyzer target values 2-15
FT target values 2-15
ion trap target values 2-14
ion trap values 2-14

Injection Control dialog box 2-14
injection waveforms 2-15–2-16, 4-8

enabling 2-15
Instrument Configuration dialog box 6-2
instrument method 2-19
instrument reset 4-10
Instrument Setup 5-3
internal reference 2-10
ion polarity 2-11

changing 2-11
mode 2-18

ion trap
automatic calibration 3-15
target values 2-14

ion trap calibration 3-7, 3-9
ion trap spectrum, of LTQ Orbitrap calibration solution 3-11–
3-12
ion trap target values 2-14
ion trap tuning, recommended settings 3-10
isolation/fragmentation efficiency 2-15

L
last successful check 3-18
lock mass abundance 2-11
Lock Mass List button 5-2
lock mass lists 2-10
lock mass settings A-3
lock masses 2-10, 5-2
Lock Masses dialog box 2-10
locking 5-2
locking feature 2-10
locking in automated runs 5-2
lockmass abundance 4-10

LTQ calibration solution 4-5
preparing 3-5

LTQ Configuration dialog box 6-3–6-4
FT Mass Lists page 6-4
FT Settings page 6-3

LTQ ESI calibration solution 3-6
LTQ Orbitrap calibration solution 3-6–3-7, 3-11, 3-20

preparing 3-6
LTQ Orbitrap Configuration dialog box 6-2

M
mass accuracy 2-15
mass lists 3-20, 6-4
mass range 2-9
mass range coverage 4-8
mass-to-charge ratios 3-20
maximum AGC target value 4-4
maximum inject time 2-9–2-10, 2-18
microscans 2-9, 2-18
minimum screen resolution 2-2
monoisotopic peaks 5-4
monoisotopic precursor selection 5-4
MRFA alone solution 4-4
MRFA signal 4-4
MSn target 2-15
multiplier gain calibration 3-14

N
negative ion mode 3-11, 3-15
non-peptide monoisotopic recognition 5-4

O
orbitrap

chamber temperature 6-3
checking the calibration 3-17
selecting as analyzer 2-8

overriding calibration values 4-10

P
parameters, of vacuum system 2-16
peak labels 2-4
peaks, charge state 2-4
performing diagnostics/checks 4-1
positive/negative mode 2-11
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Index: R
preamp evaluation 4-3
preamp input protection switches 4-3
preview mode 5-3
Profile format, compressed 2-11

R
readback values 4-12
Reduced Profile format 4-8
Reserpine 4-3
resistant noise peaks 4-4
resolution 2-9, 5-3

FT mass spectrum 2-9

S
scan description 2-8
scan header 4-6, 4-8, A-2
Scan Mode menu 2-8
scan range settings A-3
scan rate 2-9
scan time 2-9
scan time settings 2-10
Scan Time Settings dialog box 2-10
scan type 2-9
scan width 5-5
Scan widths page 5-5
selecting

calibration masses 3-2
devices 4-9
experimental parameters 4-9

semi-automatic calibration 3-2, 3-14
Semi-Automatic tab 3-14
Set device page 4-9, 4-12
settings, of manual toggles A-2
Setup menu 2-13
shortcut menus, Spectrum View 2-3
signal-to-noise ratio 4-4
SIM target 2-15
sodium dodecyl sulfate 3-6
sodium taurocholate 3-6
spectrum averaging 2-12
spectrum display options 2-4
Spectrum Display Options dialog box 2-4
Spectrum view 2-3

shortcut menu 2-3
spectrum view

shortcut menu 4-7

Spectrum view,
display options 2-3

starting, instrument configuration 6-2
statistic noise 6-3
Status view 2-5
stock solution

MRFA 3-4, 3-7
sodium dodecyl sulfate 3-6
sodium taurocholate 3-6
Ultramark 1621 3-5

storage multipole 3-17
storage transmission calibration 3-18
switching data formats 2-11
syringe pump 4-10
System Evaluation page 4-2
system evaluation procedures 4-2
system performance 4-2

T
target values 2-15, 4-10

FT analyzer 2-15
ion trap 2-14

Temperature Control Evaluation 4-3
Temperature Monitor 4-3
temperature regulation 2-17

behavior 4-3
results 4-3

temperature setpoint 2-17
temperature, of orbitrap chamber 6-3
toggles 4-6
Toggles page 4-6
total ion current 4-4
transfer multipole 3-17
transient view 4-7
transients 2-9, 4-7

averaging 2-12
tube lens, manual adjustment 3-10–3-11
tune methods 2-18
Tune Plus window 2-1–2-2, 3-3

display menu 2-12
minimum screen resolution 2-2
scan mode menu 2-8
setup menu 2-13
version 1-1
view menu 2-3

tuning
ion trap for negative ion mode 3-11
ion trap for positive ion mode 3-9

typical data sizes, of an FT spectrum A-4
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Index: U
U
User Status Display Configuration dialog box 2-5–2-7

V
vacuum

icon 2-16
system parameters 2-16

Vacuum dialog box 2-16

View menu 2-3
views

graph view 2-5
spectrum view 2-3
status view 2-5

X
Xcalibur raw file 4-7
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